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1 Getting started

Your printer is a general purpose color inkjet printer that provides high 
quality text and photos. You can use your printer by itself to print photos or 
connect it to a computer for other printing needs. The following sections will 
tell you how to set up your printer for Macintosh.

Setting up your printer 

1 Connect the power supply.

Note: Connection 2, above may not be required in some 
countries.

1

2 3
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Select Language appears on the operator panel display to indicate 
the power is on.

Note: If you need help identifying the operator panel buttons, see 
page 11.

2 Press on the operator panel to scroll through the 
languages.

3 Press Select when you see the language you want.

Select Paper Size appears on the operator panel display. 

4 Press on the operator panel to scroll through the paper 
sizes. 

5 Press Select when you see the paper size you want.

6 Continue with “Installing the print cartridges” in the following 
section.

Installing the print cartridges

1 Remove only the sticker and transparent tape from the bottom of 
the print cartridge. 

Note: Be sure to remove the tape and install the cartridges one at 
a time to prevent leaking.

or

or

Warning: DO NOT 
touch the gold 
contact area of the 
print cartridges.
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2 Insert the color cartridge in the left slot and the photo cartridge in 
the right slot.

Note: To replace the photo cartridge with a black cartridge, see 
page 48. 

3 Close the front cover.

Snap

Raise the front 
cover.

Insert the 
cartridges into the 
print cartridge 
carrier.

Push back firmly on 
the cartridge until it 
snaps securely into 
place. 

a b c

a b

c
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Loading paper

1 Pull out the paper support and paper exit tray. 

2 Place paper against the right side of the sheet feeder with the print 
side facing you.

3 Squeeze the release tab and the paper guide together, and then 
slide the paper guide to the left edge of the paper. 

Paper exit tray

Paper support

Paper guide

Release tab
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Aligning the print cartridges 

1 Load plain paper in the printer. For help loading paper, see the 
previous section.

2 Press Menu.

3 Press  until Utilities is highlighted, and then press Select.

The Utilities menu appears.

4 Press  until Align Cartridges is highlighted, and then press 
Select.

5 Press  until Yes is highlighted, and then press Select.

“Printing Page, Please Wait” message appears.

The test page prints several alignment patterns, depending on the 
cartridge combination installed. Each pattern has a number under it. 
The test page that prints is similar to the one shown:

6 Choose Values With Straightest Lines message appears, press 
Select to continue.

7 From each alignment group on the test page, find the number 
under the alignment pattern that comes closest to forming a 
straight line.

For example, in sample group A, the arrow points to the pattern that 
comes closest to forming a straight line.

Note: If you have a color and 
black cartridge combination 
installed, you will have two more 
alignment values, C and D. 
Follow the same instructions as 
you would for the color and 
photo cartridge combinations.
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The Align Cartridge Choose Values screen appears.

8 In the Align Cartridge dialog box, press to select the 
numbers from the printed test page that come closest to forming a 
straight line.

9 Press  to highlight Continue and press Select.

10 Press Menu to exit the printer menus.

Printing a test page

1 Make sure no camera card is inserted.

2 Press Print to print a test page.

Setting up your printer with Macintosh

Before you begin:

• Prepare your printer for printing. For help, see page 1.
• Make sure you have a USB cable.
• Make sure Mac OS 8.6 or Mac OS 9 is running on your Macintosh 

computer.

1 Connect the USB cable to the computer and the printer.

2 Place the KODAK PPM200 Printer Software CD into your 
computer’s CD-ROM drive. 

The KODAK PPM200 Installer main screen appears.

3 Click Install and Agree.

The KODAK License Agreement screen appears.

4 Click Accept.

The KODAK PPM200 Installer screen appears.

5 Click Install.

The KODAK PPM200 Printer Selection screen appears.

6 Follow the on-screen instructions.

or
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Note: Prior to installing the KODAK PPM200 software, you can 
choose other options such as Learn, Registering online or 
Browse (KODAK Web Site, Technical Support or Personal 
Picture Maker Supplies).

Congratulations!

You have successfully set up your printer for a Macintosh computer.

Note for Macintosh Users:

If your Macintosh computer locks up or freezes while printing, you may 
need to unplug the printer and turn off your computer. After a few seconds, 
plug the printer back in and turn your computer back on. The printer 
driver’s spooler may attempt to start printing the job that was in the queue 
before the computer locked up. This could cause your system to lock up 
again. To recover from this problem:

1 Unplug the printer and turn off your computer.

2 Hold down the Shift key and turn on the computer.

3 Press and hold the Shift key until you see the Mac OS screen and 
the words “Extensions Off”.

4 Release the Shift key.

5 Locate the KODAK PPM200 printer icon on your desktop. The 
inactive printer spooler has an X over it.

6 Double-click the icon to open the KODAK PPM200 dialog box.

7 Drag your print jobs to the trash can.

8 Restart the computer to enable extensions.

9 Plug your printer back in.
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Understanding your printer

This chapter describes the parts of your printer and their functions.

Identifying the parts of your printer 

Use this... When you want to...

Paper support Keep paper straight in the sheet feeder.

Release tab,

Paper guide

Make sure the paper feeds correctly into your 
printer. 

Sheet feeder Load paper. 

Front cover Install or change print cartridges, or clear paper 
jams.

Paper exit tray Keep paper together after printing.

Camera card cover Insert or remove a camera card.

Paper support

Release tab

Camera card 
cover 

Paper exit tray

Sheet feeder

Operator panel

Front cover
Paper guide
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Operator panel • Select setup options.
• Select photos for printing.
• Select special printing options.
• Select photo storage options.
• Display and clear status or error messages.

Use this... When you want to...

Power supply connector Plug the power supply into the printer.

USB/PC cable 
connector

Attach the printer to a computer. 

USB external device 
connector

Attach a Zip drive to the printer. 

Use this... When you want to...

Power supply 
connector

USB/PC cable 
connector

USB external 
device 
connector
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Using the operator panel 

 

Verifying camera compatibility 

Your printer is compatible with most types of digital cameras that use 
CompactFlash or SmartMedia camera cards. Visit our Web site at 
www.kodak.com/go/homeprinting for the latest camera compatibility list.

Use this... When you want to...

Menu button Enter and exit the menus.

Arrow button Navigate through the menus and view your photos.

Display window Raise or lower the display to view the menus and your 
photos.

Brightness control Adjust the brightness or contrast of the display.

Select button Select or cancel a photo, enter a submenu, or accept 
menu settings.

View/Return button Change from one view to another or return to a previous 
menu level without saving changes from the current 
menu option.

Print button Begin printing.

Menu 
button

Print button
View/Return 
button

Select 
button

Arrow 
button

Brightness 
control

Display 
window
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Inserting a camera card

Before inserting a camera card into its card slot, lift the protective cover 
located on the top of your printer.

Choosing a camera card slot

Your printer recognizes one source for photos at a time and searches for 
photos in the following order:

• Left slot (CompactFlash)
• Right slot (SmartMedia)
• Optional external devices (see page 29)

Consider the following information before inserting a camera card:

• If the camera card has a gold contact area, make sure the contact 
area faces the front of your printer.

• If you are inserting a CompactFlash card, make sure the name 
label faces the back of your printer.

• If you are inserting the SmartMedia card, make sure you do not 
place it in the CompactFlash card slot.

• If your camera card or storage disk contains photo images, a 
Reading Card message appears in the display window. The 
number of photos contained on the card is also displayed.

SmartMedia 

Gold contact 
area

CompactFlash 

Camera card 
slot cover
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Using the Quickstart screen

When you insert your camera card into your printer or if you are printing 
photos from an external device, a Quickstart screen appears that gives 
you easy print options.You do not need to enter the Main Menu of the 
printer.

The following table lists the start-up screen options:

To use the Quickstart screen:

1 Insert the appropriate camera card or connect your external device 
containing photo images.

The Quickstart screen appears.

2 Press  to scroll through the options until the selection you 
want is highlighted.

3 Press Select.

Use the up and 
down arrows to 
select... When you want to...

Print All Print all the photos from your camera card or external 
device. 

Print Camera Order Print the photo selections chosen in your camera.

Note: This option is only visible when you have selected 
photos for printing using your camera.

View Photos View and select photos for printing.

Print Index Print thumbnail size photos.

PC Card Reader View or copy photos to your computer.

Note: This option is only visible if you are connected to 
your computer. See page 38.

Change Layout Change the way your photos are printed on paper.

or
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Note: To return to the Quickstart screen, remove and reinsert 
your camera card. This resets or clears all current photo 
selections.

Using Photo and Print Preview 

These screens let you select photos and review them before printing. 

To use Photo and Print Preview:

1 Press  to highlight View Photos from the Quickstart screen and 
then to view and scroll through your photos.

2 Press Select to choose the photos you want to print.

3 Press View/Return to preview your selections.

Note: Pressing View/Return changes between photo and page 
preview screens.

4 Press Print.

Note: The Page Preview screens show what your selections will 
look like, the current settings, and the number of pages to 
be printed.

Understanding the Idle Screen

An idle screen appears on the display if there is no camera card in the 
printer. This screen provides you with the current photo printer settings. 
The display goes blank after approximately 30 minutes. Press any key on 
the operator panel, or open the printer’s front cover to activate the display.

Changing Languages

Choose the Language option to change the language that appears on the 
operator panel display.

or
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To change the Language Default:

1 Press Menu until you see the Main Menu.

2 Press  until Preferences is highlighted, and then press Select.

The Preferences menu appears.

3 Make sure Language is highlighted and press Select.

4 Press on the operator panel to scroll through and select 
the language you want.

or
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Printing photos without
a computer

This chapter describes how to print and edit photos using the printer 
menus. 

Understanding the Printer Menus

If you want to print photos using more detailed options, change print 
settings, or access other printer functions, go to the printer menu by 
pressing the Menu button. 

To use the Menu:

1 Press the Menu button. 

2 Press  to scroll and highlight the menu category you want.

 Menu Categories

PreferencesUtilitiesPaper 
Settings

StorageEdit PhotoPrint Setup

Photos to Print
Layout
Print Quality
Sets

Paper Type
Paper Size

Crop
Rotate
Add Border
Add Text
Brightness
Auto Enhance
Undo all Edits

Copy Card
Erase Card

PC Card Reader
Ink Level
Clean Cartridge
Align Cartridge
Reset Defaults

Language

or



18

P
ri

n
ti

n
g

 p
h

o
to

s 
w

it
h

o
u

t 
a 

co
m

p
u

te
r

3 Press Select.

4 Press  to navigate through the sub-menus and choose 
the option you want.

5 Press Select.

Notes: The current setting is identified with a check mark next to it. 
Press View/Return to go back one menu level or you can 
press Menu at anytime to return to Photo and Print 
Preview.

The current settings for the highlighted category appear in 
the bottom right corner of the display.

Choosing a paper type from the operator panel

1 Press Menu until you see the Main Menu.

2 Press  to highlight Paper Settings, and then press Select.

The Paper Settings menu appears showing your current 
selections.

3 Make sure Paper Type is highlighted, and then press Select.

The Paper Type menu appears.

Press  to select a paper type.

Choose this Paper 
Type... For making... For best results, use...

Photo • Ultra glossy photo prints. • KODAK Premium 
Picture Paper.

Plain • Economical photo prints. • Typical xerographic 
paper.

and

and
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We recommend KODAK Premium Picture Paper for the best print quality. 

For information about ordering paper, visit the World Wide Web at 
www.kodak.com/go/inkjet.

Choosing a paper size

1 Press Menu until you see the Main Menu.

2 Press  to highlight Paper Settings, and then press Select.

The Paper Settings menu appears showing your current 
selections.

3 Press  to highlight Paper Size, and then press Select. 

The Paper Size menu appears.

Kodak Templates

Note: After selecting 
this option, you will 
need to select the 
template number you 
are using. For a list of 
Kodak templates, see 
page 21.

• Multiple photo layouts on 
pre-perforated sheets.

• KODAK Premium 
Picture Kit for 
borderless prints.

Iron-on transfer (or 
T-Shirt)

• Photo prints for iron-on 
transfer to fabric.

• Iron-on media.

Transparencies • Transparencies for 
overhead projectors.

• Transparency media.

Choose this Paper 
Type... For making... For best results, use...
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4 Press  to select a paper size.

Changing print quality

1 Press Menu until you see the Main Menu.

2 Make sure Print Setup is highlighted, and then press Select.

The Print Setup menu appears.

3 Press  until Print Quality is highlighted, and then press Select.

4 Press  to choose from the following print quality options:

– Best
– Better (default setting)
– Good

Note: Increasing print quality reduces print speed.

5 Press Select.

Choosing the page layout 

1 Press Menu until you see the Main Menu.

2 Make sure Print Setup is highlighted, and then press Select.

The Print Setup menu appears.

3 Press  until Layout is highlighted, and then press Select.

Select this 
option... To choose...

Paper Size • 8.5 x 11
• A4 
• 4 x 6
• A6
• Hagaki

and

and
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The Page Layout menu appears. (See the following table for an 
overview of the page layout options.)

4 Press Select to save your selection or View/Return to exit the 
menu without changing the settings.

Notes: The panoramic and border options on your printer are not 
available when you use Kodak Templates.

Press the left or 
right arrow to 
scroll and 
choose...

Then, press the down arrow and then use the left and 
right arrows to scroll and choose from the following 
layout options:

Print Sizes. • 8 x10 -1 per page
• 4 x 6 - 2 per page
• 5 x 7 - 2 per page
• 3.5 x 5 - 4 per page
• 2 x 3 - 8 per page
• 1.75 x 2 - 16 per page

Kodak Templates. • EK-PH-001 - (1) 8” x 10” (letter size paper)
• EK-PH-002 - (2) 5 x 7 prints on letter size paper
• EK-PH-003 - (2) 4 x 6 prints on letter size paper
• EK-PH-004 - (4) 3.5 x 5 prints on letter size paper
• EK-PH-005 - (6) 2.5 x 3.5 prints on letter size paper
• EK-PH-009 - (3) 3.5 x 8.5 prints on letter size paper
• EK-PH-010 - (1) 4 x 6 on 8.25” x 4.5” paper
• EK-PH-011 - (1) 100 x 150 mm on A5 size paper
• EK-PH-102 - (2) 127 x 177 mm on A4 size paper
• EK-PH-103 - (2) 102 x 152 mm on A4 size paper
• EK-PH-104 -(4) 90 x 130 mm on A4 size paper
• EK-PH-105 - (6) 57 x 89 mm on A4 size paper

Panoramic
(only supported in 
letter and A4 size 
papers).

• Center
• Lower Center
• Lower
• Top
• Upper Center
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You can also use the Kodak Template menu settings with 
regular photo paper. Cut the photos to fit your frame to 
create standard size, borderless prints.

Selecting photos to print 

1 Insert the appropriate camera card.

2 Press  to highlight View Photos.

3 Press Select.

4 Press  to scroll through your photos.

5 Press Select for each photo you want to print.

6 Press to increase or decrease the number of copies for 
each selected photo.

Note: A check mark appears in the lower left corner indicating the 
photo is chosen. To remove the selection, press Select 
again.

7 Press View/Return, and then press  to review the selections 
you have chosen.

8 Press Print to begin printing or Menu to select or change other 
print settings.

Using the Photos to Print option

1 Press Menu until you see the Main Menu.

2 Make sure Print Setup is highlighted, and then press Select.

The Print Setup menu appears.

3 Make sure Photos to Print is highlighted, and then press Select.

The Photos to Print menu appears.

4 Press  to choose from the following options:

or

or

or

or



23

P
rin

tin
g

 p
h

o
to

s w
ith

o
u

t a 
co

m
p

u
ter

– Selected Photo - Prints photos selected from the operator 
panel in the full photo view.

– Print Camera Order - Prints photos you selected on your 
digital camera.

Note: Print Camera Order only appears if you have selected 
photos within the camera.

– Print All - Prints all photos.
– Print Index - Prints small numbered photos with file names.

5 Press Select.

Printing starts immediately.

Choosing the number of sets to print

Select Sets to print more than one copy of your photo grouping.

1 Press Menu until you see the Main Menu.

2 Make sure Print Setup is highlighted, and then press Select.

The Print Setup menu appears.

3 Press  until Sets is highlighted, and then press Select.

4 Press  to scroll and select the number of sets you want to 
print.

5 Press Select.

Photo Editing Selections

To edit photos currently shown on the display, select:

• Crop
• Rotate
• Add Border 

or
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• Add Text (You can also modify text when choosing this option, for 
help, see page 26.)

• Brightness
• Auto Enhance
• Undo All Edits

Notes: Edits are applied only to the current photo displayed in the 
photo view.

After you edit a photo, Edited will appear in the lower right 
corner of the display in photo view. You will only see the 
changes you made to your photo when it is printed.

Cropping photos

To crop or select specific areas of photos:

1 Press Menu until you see the Main Menu.

2 Press  to highlight Edit Photo, and then press Select.

The Edit menu appears.

3 Make sure Crop is highlighted, and then press Select.

4 Press  or  to move the crop window around the 
photo.

5 Use arrows to position the crop box.

6 Press Select.

Notes: To undo a previous crop, return to the Crop menu and 
press Select. To redo a previous crop, return to the Crop 
menu and use the arrows to reposition the crop box.

You cannot use crop and panoramic view on a photo at 
the same time.

Rotating a photo

1 Press Menu until you see the Main Menu.

and and
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2 Press  to highlight Edit Photo, and then press Select.

The Edit menu appears.

3 Press  to highlight Rotate, and then press Select.

The Rotate menu appears.

4 Press  to scroll and select an angle, and then press Select.

Notes: Depending on the photo size chosen, the rotated photo 
may print smaller than the selected size. 

Text added to you your photo will not rotate with the 
image.

Rotating TIFF images can take a very long time and is not 
recommended.

Selecting a border for your photo

1 Press Menu until you see the Main Menu.

2 Press  until Edit Photo is highlighted, and then press Select.

The Edit menu appears.

3 Press until Add Border is highlighted, and then press 
Select.

The Add Border menu appears.

4 Press  to scroll and choose a border selection.

5 Press Select.

Note: Borders are not printed when using Kodak Templates.

Adding text to your photo 

1 Press Menu until you see the Main Menu.

2 Press  until Edit Photo is highlighted, and then press Select.

or

or

or
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The Edit menu appears.

3 Press  until Add Text is highlighted, and then press Select.

The Add Text menu appears.

4 Press  to scroll and choose a text selection.

5 Press Select.

Note: Use the Modify Text option described in the following 
section to change the text selections.

Modifying text for your photo

1 Press Menu until you see the Main Menu.

2 Press  until Edit Photo is highlighted, and then press Select.

The Edit menu appears.

3 Press  until Add Text is highlighted, and then press Select.

The Add Text menu appears.

4 Press  to scroll and choose Modify Text.

The Modify Text menu appears.

5 Press  to highlight and select the text you want to modify.

6 Press Select.

7 Press , and then press Select to choose each letter or 
symbol you want.

Note: Press  until Erase Last is highlighted, and then press 
Select to erase characters, numbers, or symbols.

8 Press  to highlight Space, and then press Select to add spaces 
between text.

9 Press Done to save your text.

Notes: The letters and symbols selected appear in the text bar 
located at the bottom of the menu screen.

or

or

or

or
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Very long text messages may not print.

To set the text back to its original default settings, select 
Reset Text.

Brightness feature

To adjust the contrast of a photo, choose the Brightness feature from the 
operator panel.

1 Press Menu until you see the Main Menu.

2 Press  to highlight Edit Photo, and then press Select.

The Edit menu appears.

3 Press  to highlight Brightness, and then press Select.

4 Press  to adjust the level of brightness for your photo, and 
then press Select.

Note: Selecting the Brightness option will deactivate the Auto 
Enhance feature if previously chosen.

Auto Enhance

Use Auto Enhance to automatically improve the appearance or quality of 
your photos. 

1 Press Menu until you see the Main Menu.

2 Press  to highlight Edit Photo, and then press Select.

The Edit menu appears.

Note: Selecting Auto Enhance will deactivate the Brightness 
feature if previously chosen.

or
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3 Press  to highlight Auto Enhance, and then press Select.

4 Press  to choose from Off or On, and then press Select.

Note: Changes are applied to prints, but are not applied to the 
display image.

Resetting Defaults

Use Reset Defaults to return to your printer’s original factory settings.

1 Press Menu until you see the Main Menu.

2 Press  until Utilities is highlighted, and then press Select.

The Utility menu appears.

3 Press  until Reset Defaults is highlighted, and then press 
Select.

The Reset Defaults menu appears.

4 Press  until Yes is highlighted, and then press Select.

or
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4 Using an external Zip drive

Connecting your external Zip drive

You can copy photos from your camera card directly to a Zip drive, which is 
purchased separately. This lets you reuse your camera card and take more 
pictures. You can read photo images from these storage devices (with no 
camera card inserted).

The following external storage device is supported with your printer:

Iomega Zip™ USB attached (100 and 250MB)

To attach a Zip drive directly to your printer, see the following instructions.

Attaching your printer to the Zip drive

1 Connect the USB cable to the back of your printer and the external 
storage device.

2 Connect the power supply to the external storage device, and then 
plug it into an electrical outlet. 
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Copying photos to your Zip drive

To copy photos from the camera card to the external storage disk:

1 Insert your camera card into the appropriate slot on your printer. 
For help, see page 12.

2 Insert the storage disk into your Zip drive. 

Note: Your printer recognizes one camera card at a time. If two 
camera cards are installed, only the photos stored on the 
CompactFlash card are available. 

3 Press Menu.

4 Press the  until you see Storage, and then press Select.

The Copy and Erase options appear on the Storage menu 
screen. 

5 Make sure Copy is highlighted, and then press Select.

The Copy Card menu appears.

6 Make sure Yes is highlighted, and then press Select.

Copying Card appears with a progress bar indicating the status of 
the copy process. When the progress bar is filled, your photos 
have been copied to your external storage disk and the Storage 
menu returns.

Note: Select Cancel to stop the copy process.

7 Select View/Return to go to the Main Menu.
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Erasing photos from your camera card

After you copy your photos to an external storage disk, you can erase the 
photos from your camera card and reuse it. 

1 Insert the appropriate camera card into your printer. For help, see 
page 12.

2 Press Menu.

3 Press  until you see Storage, and then press Select.

Two options, Copy Card and Erase Card appear on the Storage 
menu screen. 

4 Press  to highlight Erase Card, and then press Select.

The Erase Card menu appears 

5 Press  to highlight Yes, and then press Select.

The Erase Card Are You Sure menu appears.

WARNING: This process erases all photos from your camera card.

6 Make sure Yes is highlighted and press Select.

Printing from your Zip disk

Remove all camera cards from your printer before printing from the 
external storage drive. The printer searches for images on the external 
storage disk only when no camera cards are installed.

To print photos from your external storage disk:

1 Load paper against the right side of the sheet feeder. For help, see 
page 4. 

Note: For best print quality, use KODAK Premium Picture Paper.

2 Insert your storage disk into your Zip drive.
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The Quick Start menu appears.

3 Select your print options, and then press Print.

Note: For the best print quality, remove each printed photo from 
the paper exit tray before the next one prints.
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5 Printing with Macintosh 

This chapter describes how to use your printer with Mac OS 8.6 and 
Mac OS 9. 

Follow these basic steps for printing:

1 Load the paper (see page 4).

2 Customize the printing options (see page 35).

3 Print your document (see page 38).
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Step 1: Load the paper

Load paper against the right side of the sheet feeder. For help, see page 4.

Loading other paper types

Load up to: Make sure:

10 photo cards • The print side is facing you.
• The cards are loaded vertically against the right side 

of the sheet feeder.
• The paper guide is against the side of the cards.

25 sheets of photo 
paper

• The glossy or coated side is facing you.
• The paper guide is against the side of the paper.

10 transparencies • The rough side of the transparency is facing you 
(smooth side down).

• The paper guide is against the edge of the 
transparencies.

100 sheets of custom 
size plain paper

• The print side is facing you and the paper guide is 
against the side of the paper.

• Your paper size fits within these dimensions:
– Width:

76 - 215.9 mm
3 - 8.5 in.

– Height:
127 - 355.6 mm
5 - 14.0 in.

25 iron-on transfers • You follow the instructions on the packaging to load the 
iron-on transfers.

• The paper guide is against the side of the iron-on 
transfers.
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Step 2: Customize the printing options

Your printer software works with your operating system to help you print 
documents with superior results. To customize your printing options, you 
will need to use the Page Setup dialog box and the Print dialog box.

Page Setup dialog box

Print dialog box 

Click the… When you want to… 

Help button Access the printer driver help.

General pop-up menu • Select paper size
– View the available paper sizes.

• Select scaling
– Change the scaling value of the document. 

Valid values are between 25% and 400%.
• Select orientation

– Choose between portrait and landscape 
modes.

Watermark pop-up menu Select Watermarks

• Choose the watermark you want.

Click this… When you want to…

Help button Access the printer driver help.

General pop-up menu • Select Copies 
– Type in the number of copies (1-99).

• Select Pages 
– Print all pages or a given page range.

• Select Wait for pages to dry 
– Add more time between pages as they exit the 

printer.

Layout booklet printing, pages per sheet, print last page first, 
print on both sides, and binding.

Color ColorSync or Built-In color matching.
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To change the paper size, orientation, scaling, and watermark 
settings:

1 From the File menu, choose Page Setup.

The Page Setup dialog box opens.

2 Change the settings as needed.

3 Select OK.

Changing the print settings from an application

To change the print settings from an application (for example, 
word processing, spreadsheet, graphics, and so on):

1 Open the application’s File menu.

2 Choose Print.

The Print dialog box opens.

3 Change the settings as needed.

4 Select Save Settings.

Changing the print settings from the desktop

To change the print settings from the desktop:

1 From the desktop, open the File menu.

Background Printing print in foreground, print in background, or print time.

Paper Type/Quality 
pop-up menu

• Select from the following Paper Types:
– KODAK Premium Picture Paper.
– Plain Paper
– Transparency
– Iron-On Transfer

• Select Print Quality
– Choose from Quick Print (600 dpi), Normal 

(600 dpi), or High (1200 dpi).

Click this… When you want to…
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2 Choose Print.

The Print dialog box opens.

3 Change the settings as needed.

4 Select Save Settings.

Changing the printing options for specialty paper

When you installed the printer software, the Page Setup dialog box and the 
Print dialog box were set to the default settings. Use these default settings 
for printing most documents on plain paper. To change the print settings for 
printing on specialty paper, use the following table.

When you are 
printing on:

Open this 
dialog box: To make these selections:

KODAK Premium 
Picture Paper

Print 1 On the Paper Type/Quality pane, 
select Kodak Premium Picture 
Paper.

2 Select High (1200 dpi) for the Print 
Quality. 

3 On the Color pane, select Built-In 
Color Matching.

4 From the Document Color pop-up 
menu, select Natural Color.

Note: You can print quality photos with 
the black and color cartridge 
combination. However, for the best 
possible photo quality, replace the black 
cartridge, with Kodak photo cartridge 
CAT 175 4852. For help, see page 48.

When printing photos, remove each 
photo as it exits the printer and allow it to 
dry before stacking.

Transparencies Print On the Paper Type/Quality pane, select 
Transparency for the Paper Type and 
Normal (600 dpi) for the Print Quality.

Note: When printing transparencies, 
remove each transparency as it exits the 
printer and allow it to dry before stacking.
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Step 3: Print your document 

1 Open the File menu.

2 Choose Print. 

The Print dialog box opens.

3 Select Print.

Understanding the Card Reader

You can use your printer to load the pictures on your camera card directly 
to your hard disk drive.

To use the card reader from the Start-up screen:

1 Insert your camera card into the appropriate camera card slot.

2 Press  until PC Card Reader is highlighted, and then press 
Select.

3 Press  until Yes is highlighted and press Select.

The PC Card Reader Active screen appears.

Iron-On transfer Print On the Paper Type/Quality pane, select 
Iron-On Transfer for the Paper Type.

Note: To ensure that the iron-on transfer 
will print correctly, you may want to print 
on plain paper before printing on an 
iron-on transfer.

Sheets of custom 
size paper

Page Setup From the Paper Size pop-up menu, 
select Edit Custom Paper Sizes and 
enter the dimensions for your custom 
paper size.

When you are 
printing on:

Open this 
dialog box: To make these selections:
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To use the card reader from the Main Menu:

1 Press Menu until you see the Main Menu.

2 Press  until Utilities is highlighted, and then press Select.

3 Make sure PC Card Reader is highlighted, and then press Select.

4 Press  until Yes is highlighted and press Select.

The PC Card Reader Active screen appears.

Notes: The card slots on your printer will show up on the desktop 
as self-mounting removable drives until you exit the card 
reader mode from the operator panel. To exit the PC Card 
Reader mode, press Select.

The printer cannot print while in PC Card Reader mode. To 
print a photo that is on your camera card, you must first 
copy it to another location on your PC.
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Printing beyond the basics

You can use your printer to print:

• Both sides of a sheet of paper (on this page)
• Handouts (see page 42)
• Booklets (see page 44)
• Last page first

Printing on both sides of a sheet of paper 

Your Kodak printer lets you print on both sides of a sheet of paper. Besides 
saving paper, this feature is helpful when you want to print booklets or 
tablets.

Note: This feature does not work with all paper types. Be sure to 
check if your paper supports two-sided printing.

Step 1: Load the paper

Load paper against the right side of the sheet feeder. For help, see page 4.

Step 2: Customize the Print dialog box to print on both sides of 
the paper

1 Open the Page Setup dialog box.

2 Select the appropriate paper size.

3 Select the appropriate page orientation.

4 Open the Print dialog box.
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5 From the General pop-up menu, select Layout.

6 Select Print on Both Sides.

7 Select the appropriate graphic for the binding edge you want. You 
can either bind on the left edge or on the top edge of the paper.

Step 3: Print your two-sided document

1 Select Print.

2 The odd-numbered pages print first. When the odd-numbered 
pages finish printing, your printer software prompts you to reload 
the paper.

3 Click Continue. The even-numbered pages print on the other side 
of the stack.

To return to single-sided printing:

1 Open the Print dialog box.

2 From the General pop-up menu, select Layout.

3 Click Print on Both Sides to deselect this option.

Printing handouts 

You can conserve paper by printing handouts or multiple page images on a 
single sheet of paper. 

a Remove the stack 
of paper from the 
exit tray.

b Flip the stack.

c Insert the stack of 
paper and 
instruction page 
with the printed 
side facing away 
from you and the 
arrows pointing 
down.



43

P
rin

tin
g

 b
eyo

n
d

 th
e b

asics

Step 1: Load the paper 

Load paper against the right side of the sheet feeder. For help, see page 4.

Step 2: Customize the Print dialog box for Pages per Sheet 
(handouts)

You can print your handouts on one side of the paper or on both sides of 
the paper.

1 Open the Page Setup dialog box.

2 Select the appropriate paper size.

3 Select the appropriate page orientation.

4 Open the Print dialog box.

5 From the General pop-up menu, select Layout.

6 From the Pages per Sheet pop-up menu, select the number of 
page images you want to print on a single sheet.

The graphic changes to show you how the printed page will look.

7 Select Print Borders if you want the borders to print first.

8 To print your handout on both sides of the paper, select Print on 
Both Sides.

9 Select the appropriate graphic for the binding edge you want.

Step 3: Print your handouts

1 Select Print.

If you formatted your handouts to print on one side of each page, 
you are finished. If you formatted your handouts to print on both 
sides of each page, continue with printing the second side of your 
handouts.

2 When the first half of your handouts is finished printing, your 
printer software prompts you to reload the paper. Insert the paper 
and instruction page with the printed side facing away from you 
and the arrows pointing down.
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Note: The direction of the arrows on your instruction page may be 
different than the instruction page shown. Always insert 
the stack of paper and instruction page with the arrows 
pointing down. For help, see page 42.

3 Select Continue.

To return to normal printing: 

1 Open the Print dialog box.

2 From the General pop-up menu, select Layout.

3 Click Print on Both Sides to deselect this option.

Printing booklets

You can print and bundle your document together to make a booklet.

Step 1: Load the paper 

Load paper against the right side of the sheet feeder. For help, see page 4.

Step 2: Customize Printer Properties for booklets

1 Open the Page Setup dialog box.

2 Select the appropriate paper size.

3 Select the appropriate page orientation.

4 Open the Print dialog box.

5 From the General pop-up menu, select Layout.

6 From the Booklet Printing pop-up menu, select the appropriate 
number of sheets to bundle.

Notes: A bundle is the number of sheets of paper folded together. 
For help, see Building a Booklet.
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When printing with a heavier paper stock, select a smaller 
number of sheets to bundle to allow for binding 
considerations.

Step 3: Print and assemble your booklet

1 Select Print.

When the first half of your booklet is finished printing, your printer 
software prompts you to reload the paper.

2 Insert the stack of paper and paper reloading instruction page with 
the printed side facing away from you and the arrows pointing 
down. 

Note: For help reloading and printing two-sided pages for your 
booklet, see page 42.

3 Select Continue.

Building a booklet

1 Take the first bundle from the paper exit tray, fold it in half, and set 
it aside.

2 Take the next bundle, fold it in half, and stack it on top of the first 
bundle.

3 Fold and stack the rest of your bundles, one on top of the other, 
until your booklet is complete.

4 Bind the bundles together to complete your booklet.
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Printing last page first

Step One: Load the paper

Load up to 100 sheets of paper against the right side of the sheet feeder. 
For help loading paper, see page 4.

Step Two: Customize the Print dialog box to print the last page 
first

1 Open the Page Setup dialog box. For help, see page 35.

2 Select the appropriate paper size.

3 Select the appropriate page orientation.

4 Open the Print dialog box. For help, see page 35.

5 From the General pop-up menu, select Layout.

6 Select Print Last Page First.

7 Select Print.
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7 Caring for your cartridges

This chapter describes how to perform cartridge maintenance. You can 
install or replace cartridges, view ink levels, clean and align cartridges 
using your computer, or printer’s operator panel. If your printer is 
connected to a computer, it may be more convenient to do these 
operations from your computer.

Using your computer for cartridge maintenance

To perform cartridge maintenance from your computer, you must open the 
Control Panel.

To open the Control Panel from the Apple menu, click:

1 Control Panels

2 KODAK PPM200 Control Panel
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KODAK PPM200 Control Panel

The following functions are available in the KODAK PPM200 Spooler

• Monitor the status of your print job.
• Cancel your print job.

Note: You can access the Spooler by double-clicking the 
KODAK PPM200 icon on your desktop.

Installing or replacing print cartridges

1 Raise the front cover. The print cartridge carrier moves to the 
loading position unless the printer is busy.  

Click the: When you want to:

Cartridges tab • Install or replace print cartridges.
• Clean the print nozzles.
• Align print cartridges for best print quality.
• View cartridge part numbers and order supplies directly 

from Kodak’s Web site.
• Print a test page. 
• View your ink levels.

About tab Find the printer software version and copyright notice.

Help button Access the printer driver Help on any tab in the Control 
Panel.

Print cartridge 
carrier in the 
loading position

Front 
cover
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2 Remove the old print cartridge. Store it in an air-tight container or 
dispose of it. 

3 Match the cartridge cap color to the cartridge carrier color and 
install the cartridge in the printer:

Note: For the best possible photo quality, replace the black 
cartridge with a photo cartridge and print with a photo and 
color cartridge combination. 

4 Close the front cover.

5 From the Control Panel’s Cartridges tab, select Install/Change 
Cartridge. 

6 Select the type of cartridge you installed and click OK.

7 If you installed a new cartridge, the Alignment dialog box displays. 
Follow the instructions on the Alignment screen to complete the 
cartridge installation. For help, see the next section.

Photo cartridge
CAT 175 4852

Color cartridge
CAT 195 1730

Black cartridge
CAT 136 9511

Push back firmly 
on the cartridge 
until it snaps 
securely into 
place.

Insert the print 
cartridge into the 
print cartridge 
carrier.

If you are installing a 
new cartridge, remove 
only the sticker and the 
transparent tape from 
the bottom of the print 
cartridge.

a b c

Snap
WARNING: 
DO NOT 
touch the 
gold contact 
area of the 
print cartridge.
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Aligning print cartridges

If the print quality is not satisfactory, a simple cartridge alignment may 
improve print quality. If print quality is still not satisfactory after aligning the 
print cartridges, you may need to clean the print nozzles.

1 Load plain paper in the printer. For help loading paper, see page 4.

2 From the Control Panel’s Cartridges tab, select Align Cartridges. 

Your printer prints an alignment test page and the Align Cartridge 
dialog box is displayed. 

The test page prints several alignment patterns, depending on the 
cartridge combination installed. Each pattern has a number under 
it. The test page that prints is similar to the one show:

3 From each alignment group on the test page, find the number 
under the alignment pattern that comes closest to forming a 
straight line.

For example, in sample group A, the arrow points to the pattern 
that comes closest to forming a straight line.

4 In the Align Cartridges dialog box, enter the pattern numbers 
from the printed test page that come closest to forming a straight 
line.

5 After you have entered a number for all of the patterns, click OK.

Note: If you have a color and 
black cartridge combination 
installed, you will have two more 
alignment values, C and D. 
Follow the same instructions as 
you would for the color and 
photo cartridge combinations.
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Cleaning print nozzles

1 Load plain paper in the printer.

2 From the Control Panel’s Cartridges tab, select Clean Print 
Nozzles. 

The printer feeds a sheet of paper and prints a nozzle test pattern 
similar to the one shown:

3 Compare the diagonal line above the printed bars to the diagonal 
line below the printed bars.

Look for a break in the diagonal lines above the printed bars. A 
broken line indicates clogged nozzles. 

If the bottom line still has breaks, run the test up to two more times. 

– If the print quality is satisfactory after running the test three 
times, the print nozzles are clean. You do not need to 
complete the remaining steps.

– If the print quality of both lines is not satisfactory after running 
the test three times, continue with step 4.

4 Remove and reinstall the print cartridge. 

5 Repeat the nozzle test. 

6 If the lines are still broken, wipe the print cartridge nozzles. For 
help, see “Wiping print nozzles and contacts” on page 53.

Broken lines at the top 
of the page indicate 
clogged nozzles.

Unbroken lines at the 
bottom of the page 
indicate the nozzles 
were cleaned.

Cyan, magenta, 
yellow, and 
black solid lines 
(shown here in 
black and white) 
print when ink is 
forced through 
the print 
nozzles to 
unclog them. 
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Using your operator panel for cartridge 
maintenance

Installing or Replacing Print Cartridges

1 Install or replace your print cartridges. For help, follow steps 1 
through 4, beginning on page 48.

When you begin a print job, the printer will ask you to select the 
type of cartridges installed.

2 Select the correct option and press Select.

Note: If you installed new cartridges, the printer will ask if you 
want to align them. To align the print cartridges, insert a 
sheet of plain paper, choose Yes from the operator panel, 
and then press Select.

3 Follow the alignment process on page 5.

Aligning the Print Cartridges

See page 5.

Cleaning print nozzles

1 Press Menu until you see the Main Menu.

2 Press  until Utilities is highlighted, and then press Select.

The Utilities menu appears.

3 Press  until Clean Cartridge is highlighted, and then press 
Select.

The Clean Cartridge menu appears.

4 Press  until Yes is highlighted, and then press Select.
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The Cleaning Cartridge menu appears with a progress bar 
showing the status of the cleaning process. When the progress bar 
is complete, the Utilities menu returns.

Note: The printer feeds a sheet of paper and prints a nozzle test 
pattern similar to the one shown on page 51.

5 Follow steps 3 through 5 on page 51.

6 If the lines are still broken, wipe the print cartridge nozzles. For 
help, see “Wiping print nozzles and contacts” on page 53.

7 Press Print or use the View/Return button to go to other menu 
options.

Viewing ink levels

1 Press Menu until you see the Main Menu.

2 Press  until Utilities is highlighted, and then press Select.

The Utilities menu appears.

3 Make sure Ink Level is highlighted, and then press Select.

The Ink Level menu appears.

4 View the ink level. 

5 Select Done when you are finished checking the ink level.

Cleaning and preserving print cartridges

Wiping print nozzles and contacts

If print quality does not improve after cleaning the print nozzles, there may 
be dried ink on the print cartridge nozzles or the print cartridge contacts. 

To wipe the print cartridge nozzles and contacts:

1 Remove the print cartridge from your printer. For help, see 
page 48.
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2 Dampen a clean lint-free cloth with water and gently wipe the 
entire gold-colored area, including the nozzles.

WARNING: Wipe the nozzles in one direction so the colors do not 
mix.

3 To dissolve dried ink, hold the damp cloth against the nozzles for 
about three seconds. Gently blot and wipe dry.

4 Dampen another section of clean, lint-free cloth with water and 
gently wipe the entire gold-colored area, including the contacts. 

WARNING: When cleaning the print cartridge, wipe the contacts in 
one direction.

5 To dissolve dried ink, hold the damp cloth against the contacts for 
about three seconds. Gently blot and wipe dry. Allow the 
gold-colored areas to dry before you reinsert the cartridge into 
your printer.

Reinstall the print cartridge and repeat the nozzle test. For help, see 
page 51.

Nozzles

Contacts
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Preserving print cartridges

To ensure the longest life from your print cartridge and optimum 
performance from your printer:

• Keep a new print cartridge in its packaging until you are ready to 
install it.

• If a print cartridge runs out of ink, leave the empty cartridge in the 
printer until you are ready to replace it. Printing with one of the 
print cartridge carriers empty may cause printer problems.

• Do not remove a print cartridge from the printer except to replace, 
clean, or store it in an air-tight container. The print cartridge does 
not print correctly if removed from the printer and left exposed for 
an extended period of time.

The printer warranty does not cover repair of failures or damage caused by 
a refilled cartridge. Kodak does not recommend use of refilled cartridges. 
Refilling cartridges can affect print quality and cause damage to the printer. 
For best results, use Kodak supplies.
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Troubleshooting

Understanding the operator panel error 
messages

Cannot read Card

Check your camera card. The card may not have photos on it or it may be 
damaged.

Carrier Stall

The cartridge carrier inside your printer has stalled. Unplug your printer, 
clear the paper jam, and then plug your printer back in. For help clearing 
paper jams, see page 59.

Copy Failed Disk Full

Your external storage disk is full. Insert a new disk to store additional 
photos. 

Copy Failed, Write Protected

The external storage disk you are using is write protected. You must 
remove write protect from your disk before you copy photos.
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Copy Failed No Disk

Your printer does not recognize your external storage drive. Check your 
external storage drive cable connections to make sure they are secure. 

Decode Error 

Your printer can’t read your camera card. This is often caused by removing 
your camera card from your camera before it has finished storing the 
image. It can also be caused by photos that have been previously 
uploaded to a computer and modified. 

Note: If the printer is connected to a computer, try viewing your 
photos from the card reader mode. For help using the card 
reader, see page 38.

Erase Failed

The photos cannot be erased from your disk. Make sure your disk is not 
write protected.

Insert Paper, Press Print

The printer is out of paper. For help loading paper, see page 4.

Install Cartridge

Install a cartridge. For more information, see page 2.

Low Ink

Check your ink levels, it may be time to replace a cartridge. To check your 
ink levels from your computer, see page 48. To view your ink levels from 
your printer’s display, see page 53.
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No PC is Connected

This error message appears when you choose the Card Reader option 
from the operator panel and no computer is connected. Card Reader is a 
function that interacts with your computer. For help, see “Understanding 
the Card Reader” on page 38.

Paper Jam

Try removing the paper from the sheet feeder. If the paper is lodged too far 
into the printer and can’t be removed:

1 Unplug your printer.

2 Pull firmly on the paper to remove it. If you cannot reach the paper 
because it is too far into the printer, raise the front cover and pull 
the paper out.

3 Close the front cover.

4 Plug your printer into an electrical outlet.

Resend your document to print.

PC Printing in Progress

Wait until the print job from your computer is complete and then press 
Print on the operator panel to begin printing photos.

Printing problems without a computer

My printer will not read my camera card

• Remove your camera card for 15 seconds, and then reinsert.
• There may not be any photos on your camera card.
• Your camera card may not be supported by your printer.
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The colors on my printed photos do not print correctly

• Your cartridge may be running out of ink and you may need to 
replace your print cartridge. For help, see page 48.

• Check your paper. Photos can print with color variations 
depending upon the type of paper you have loaded in your printer. 
For the best print results, use KODAK Premium Picture Paper.

Printed pages have alternating bands of light and dark 
print (intermittent printing)

Select Best print quality setting from your printer’s operator panel. 
For help, see page 20.

My photo prints, but there is too much white space on the 
paper

• Make sure the paper size selected under PRINT OPTIONS 
matches the paper size loaded in your printer. For help selecting 
the correct paper size, see page 19.

• You may not have selected enough photos to print on one page. 
For help, see “Choosing the page layout” on page 20.

Printer prints very slowly

Select a lower print quality setting.

Note: If you are printing photos, it may take longer to print than 
regular text.
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Printing problems with your computer

When your printer has a problem, first make sure that:

• The power supply is plugged into the printer and a properly 
grounded electrical outlet.

• The printer is plugged in.
• The printer USB cable is securely attached to your computer and 

printer.

Printer prints very slowly

• Close any open applications not in use.
• Select a lower print quality setting.
• Consider purchasing more memory, or increasing the virtual 

memory for your computer.

Note: If you are printing photos or your document contains 
graphics, it may take longer to print than regular text.

Printer is plugged in but doesn’t print, or you get a Printer 
Offline message

Make sure:

• The printer is on and the paper is loaded correctly.
• The USB cable is completely plugged into the printer.
• The printer is set as the default printer.
• The printer is not set up as a card reader. For help, see page 38.
• The print job is not being held or paused in the print queue. 

1 From the desktop, double-click the KODAK PPM200 icon.

2 From the menu bar, choose Printing.

3 Choose Start Print Queue.

Print a test page (see page 6). If the test page prints, the printer is 
functioning properly. Check your application. 
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Test page does not print

Make sure:

• You have removed the tape from the cartridges. For help, see 
page 2.

• Your print cartridges are properly installed. For help, see page 2.
• The printer is set as the default printer.

Printed pages have alternating bands of light and dark 
print (intermittent printing)

Select the High 1200 x 1200 dpi Print Quality setting on the 
Page Setup dialog box.

The printer settings I selected changed

When you change printer settings from your application, the 
settings apply only to the specific document you opened with that 
application. To make the settings apply to all documents, see 
page 36.

Transparencies or photos contain white lines

• Select the High Quality 1200dpi setting.
• Your print nozzles may need cleaning. For help, see page 51.

General printing problems with or without your 
computer

Printer ejects a blank page after appearing to print 

Make sure:

• You have removed the sticker and transparent tape covering the 
gold area on the print cartridges. For help, see page 2.

• Your Kodak printer is set as the default printer on your computer.
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Paper misfeeds or pulls multiple sheets through the 
printer 

Make sure:

• You are using a paper recommended for inkjet printers.
• You do not force the paper down into the printer when you load it. 
• You do not load too much paper in the sheet feeder. Depending on 

the thickness of your paper, the sheet feeder can hold up to 100 
sheets of plain paper or 25 sheets of KODAK’s Premium Picture 
Paper.

• The left paper guide does not cause the paper to bow in the sheet 
feeder.

• The printer is on a flat, level surface.

Printer has a paper jam

See page 59.

Vertical straight lines are not smooth

To improve the print quality of vertical straight lines in tables, borders, and 
graphs:

• Select a higher Print Quality setting. For help, see page 20 or 35. 
• Test the cartridge alignment. For help, see page 5 or 50.
• Clean the print nozzles. For help, see page 51 or 52.

Print is too dark or smudged

Make sure:

• You let the ink dry before handling the paper.
• The Paper Type setting matches the paper type loaded in the 

printer.
• The paper is straight and unwrinkled.
• The print quality setting is appropriate for the paper type. If you are 

printing on regular paper, select the Quick Print 300 x 600 dpi 
Print Quality setting.
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Note: If print quality still has not improved, you may need to clean 
the print nozzles. For help, see page 52 or 52.

Colors are not printing correctly

• For ColorSync color matching, select the profile and rendering 
intent you want:

1 From the File menu, choose Print....

2 From the General pop-up menu, select Color.

3 Select ColorSync Color Matching.

4 Select the Printer Profile you want.

5 Select the Rendering Intent you want.

• For Built-In color matching, select Natural Color as the Document 
Color:

1 From the File menu, choose Print....

2 From the General pop-up menu, select Color.

3 Select Built-In Color Matching.

4 From Document Color, select Natural Color.

• Your print cartridge may be low on ink. Check the ink levels from 
the Control Panel.

• Use a different brand of paper. Every paper brand accepts ink 
differently and prints with slight color variations. For best print 
results, use KODAK Premium Picture Paper.

• Clean the print nozzles. For help, see page 51 or 52.

Glossy photo papers or transparencies stick together

• Remove each page as it exits the printer and allow it to dry before 
stacking.

• Use a transparency or photo paper designed for an inkjet printer.
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KODAK Customer Support Center

Prior to contacting Kodak, please have the following information available 
so we may serve you faster. (Located on the back of the printer.)

Machine Type number

Serial number

Date purchased

Store where purchased

United States and Canada 

1-877-774-6837

Or you may contact Kodak through our Web 
site:www.kodak.com/go/homeprinting

Support Center Hours of Operation:

9 AM-9 PM Monday through Friday and 
12 PM-6 PM Saturday and Sunday (Eastern Time).
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Appendix

In this section, you can find 
information about:

• Installing printer software
• Uninstalling printer 

software
• Warranty
• Notices
• Safety

Installing printer 
software
You can obtain the printer 
software using the:

• Compact disc (CD-ROM) 
that came with your 
printer 

• World Wide Web

If your printer software does 
not install properly, a 
communications error 
message appears when you 
try to print. You may need to 
uninstall, and then reinstall 
the printer software. For help 
see Uninstalling printer 
software. For help installing 
your software, see page 6.

Using the World Wide 
Web
If your computer does not 
have a CD-ROM drive, you 
can download the printer 
software from the World 

Wide Web at http://
www.kodak.com/go/
ppm200.

1 At KODAK’s Web site, 
select the appropriate 
driver for your operating 
system.

2 Select Save to Disk.

3 Download according to 
your operating system 
requirements.

Uninstalling 
printer software 
for Macintosh
If your printer software does 
not install properly, you may 
need to uninstall and 
reinstall the software.

To uninstall the printer 
software:

1 Drag the printer icon to 
the trash can on the 
desktop.

2 Insert the software CD.

The KODAK PPM200 
Installer screen appears.

3 Click Install and Agree.

4 From the Easy Install 
pop-up menu, choose 
Uninstall.

5 Select Complete 
Uninstall.

6 Click Uninstall.

Statement of 
Limited Warranty 
Lexmark International, Inc., 
Lexington, KY

This warranty applies to the 
United States and Canada. 
For customers outside the 
U.S. and Canada, refer to 
the country-specific warranty 
information that came with 
your printer. 

KODAK Personal Picture 
Maker 200 by Lexmark

This Statement of Limited 
Warranty applies to this 
product if it was originally 
purchased for your use, and 
not for resale, from Lexmark 
or a Lexmark remarketer 
including KODAK, referred 
to in this statement as 
“Remarketer.” 

Warranty 
Lexmark warrants that this 
product:

• Is manufactured from new 
parts, or new and 
serviceable used parts, 
which perform like new 
parts,
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• Is free from defects in 
material and 
workmanship,

• Conforms to Lexmark’s 
official published 
specifications, and

• Is in good working order.

If this product does not 
function as warranted during 
the warranty period, contact 
a Remarketer or Lexmark for 
repair without charge.

If you transfer this product to 
another user, warranty 
service under the terms of 
this statement is available to 
that user for the remainder of 
the warranty period. You 
should transfer proof of 
original purchase and this 
statement to that user.

Warranty Service
The warranty period is 12 
months and starts on the 
date of original purchase as 
shown on the purchase 
receipt.

To obtain warranty service 
you may be required to 
present proof of original 
purchase. Warranty service 
will be provided at a 
Lexmark designated 
location.

When warranty service 
involves the exchange of a 
product or part, the item 
replaced becomes the 
property of the Remarketer 
or Lexmark. The 
replacement may be a new 
or repaired item. The 
replacement item assumes 
the remaining warranty 
period of the original 
product.

Replacement is not available 
to you if the product you 
present for exchange is 
defaced, altered, in need of 
a repair not included in 
warranty service, or 
damaged beyond repair. 
Also, such product must be 
free of any legal obligation or 
restrictions that prevent its 
exchange.

Before you present this 
product for warranty service, 
remove all programs, data, 
and removable storage 
media.

For further explanation of 
your warranty alternatives 
and the nearest Lexmark 
authorized servicer in your 
area, please call 
1-888-774-6837.

Free remote technical 
support is provided for this 
product throughout its 
warranty period. Lexmark 
offers a variety of extended 
warranty programs that 
include an extension of 
technical support. For 
products no longer covered 
by a Lexmark warranty, 
technical support may only 
be available for a fee.

Extent of Warranty
Lexmark does not warrant 
uninterrupted or error-free 
operation of a product.

Warranty service does not 
include repair of failures 
caused by:

• Modification or 
attachments

• Accidents or misuse
• Unsuitable physical or 

operating environment

• Maintenance by anyone 
other than Lexmark or a 
Lexmark authorized 
servicer

• Operation of a product 
beyond the limit of its duty 
cycle

• Failure to have installed a 
maintenance kit as 
specified (if applicable)

• Use of printing media 
outside of Lexmark’s 
published specifications

• Use of other than 
KODAK’s inkjet cartridges 
manufactured by 
Lexmark

• Use of other than 
Lexmark provided 
product or component

ALL EXPRESS AND 
IMPLIED WARRANTIES, 
INCLUDING THE IMPLIED 
WARRANTIES OF 
MERCHANTABILITY AND 
FITNESS FOR A 
PARTICULAR PURPOSE, 
ARE LIMITED IN 
DURATION TO THE 
WARRANTY PERIOD. NO 
WARRANTIES, EXPRESS 
OR IMPLIED, WILL APPLY 
AFTER THIS PERIOD.

KODAK DISCLAIMS ALL 
WARRANTIES, EITHER 
EXPRESSED OR IMPLIED.

Limitation of Liability
Your sole remedy under this 
Statement of Limited 
Warranty is set forth in this 
section. For any claim 
concerning performance or 
nonperformance of Lexmark 
or a Remarketer for this 
product under this Statement 
of Limited Warranty, you 
may recover actual damages 
up to the limit set forth in the 
following paragraph.
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Lexmark's liability for actual 
damages from any cause 
whatsoever will be limited to 
the greater of 1) $5,000 or 2) 
the amount you paid for the 
product that caused the 
damages. This limitation of 
liability will not apply to 
claims by you for bodily 
injury or damage to real 
property or tangible personal 
property for which Lexmark 
is legally liable. IN NO 
EVENT WILL LEXMARK 
OR REMARKETER BE 
LIABLE FOR ANY LOST 
PROFITS, LOST SAVINGS, 
INDIRECT OR 
INCIDENTAL DAMAGES, 
OR OTHER ECONOMIC 
CONSEQENTIAL 
DAMAGES. This is true 
even if you advise Lexmark 
or a Remarketer of the 
possibility of such damages. 
Lexmark is not liable for any 
claim by you based on a 
third party claim. 

This limitation of remedies 
also applies to any 
developer of materials 
supplied to Lexmark. 
Lexmark’s and the 
developer’s limitations of 
remedies are not cumulative. 
Such developer is an 
intended beneficiary of this 
limitation. 

Additional Rights
Some states do not allow 
limitations on how long an 
implied warranty lasts, or do 
not allow the exclusion or 
limitation of incidental or 
consequential damages. If 
such laws apply, the 

limitations or exclusions 
contained in this statement 
may not apply to you.

This warranty gives you 
specific legal rights. You 
may also have other rights 
which vary from state to 
state.

Electronic 
emission notices

Federal 
Communications 
Commission (FCC) 
Compliance 
Information 
Statement
The KODAK Personal 
Picture Maker 200 by 
Lexmark, Type 4103-P01 
has been tested and found 
to comply with the limits for a 
Class B digital device, 
pursuant to Part 15 of the 
FCC Rules. Operation is 
subject to the following two 
conditions: (1) this device 
may not cause harmful 
interference, and (2) this 
device must accept any 
interference received, 
including interference that 
may cause undesired 
operation.

The FCC Class B limits are 
designed to provide 
reasonable protection 
against harmful interference 
in a residential installation. 
This equipment generates, 
uses and can radiate radio 
frequency energy and, if not 
installed and used in 
accordance with the 
instructions, may cause 

harmful interference to radio 
communications. However, 
there is no guarantee that 
interference will not occur in 
a particular installation. If 
this equipment does cause 
harmful interference to radio 
or television reception, which 
can be determined by 
turning the equipment off 
and on, the user is 
encouraged to try to correct 
the interference by one or 
more of the following 
measures:

• Reorient or relocate the 
receiving antenna.

• Increase the separation 
between the equipment 
and receiver.

• Connect the equipment 
into an outlet on a circuit 
different from that to 
which the receiver is 
connected.

• Consult your point of 
purchase or service 
representative for 
additional suggestions.

The manufacturer is not 
responsible for any radio or 
television interference 
caused by using other than 
recommended cables or by 
unauthorized changes or 
modifications to this 
equipment. Unauthorized 
changes or modifications 
could void the user's 
authority to operate this 
equipment.

To assure compliance with 
FCC regulations on 
electromagnetic interference 
for a Class B computing 
device, use a properly 
shielded and grounded cable 
such as Lexmark part 
number 43H5856 for USB 
attach. Use of a substitute 
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cable not properly shielded 
and grounded may result in 
a violation of FCC 
regulations.

Any questions regarding this 
compliance information 
statement should be directed 
to: 

Director of Lab Operations
Lexmark International, Inc.
740 West New Circle Road 
Lexington, KY 40550
(859) 232-3000

Notices

Industry Canada 
Compliance 
Statement 
This Class B digital 
apparatus meets all 
requirements of the 
Canadian 
Interference-Causing 
Equipment Regulations.

Avis de conformité 
aux normes 
d’Industrie Canada
Cet appareil numérique de la 
classe B respecte toutes les 
exigences du Règlement sur 
le matériel brouilleur du 
Canada.

European 
Community (EC) 
directives 
conformity 
This product is in conformity 
with the protection 
requirements of EC Council 

directives 89/336/EEC and 
73/23/EEC on the 
approximation and 
harmonization of the laws of 
the Member States relating 
to electromagnetic 
compatibility and safety of 
electrical equipment 
designed for use within 
certain voltage limits. 

A declaration of conformity 
with the requirements of the 
Directive has been signed by 
the Director of 
Manufacturing and 
Technical Support, Lexmark 
International, S.A., Boigny, 
France. 

This product satisfies the 
Class B limits of EN 55022 
and safety requirements of 
EN 60950.

Japanese VCCI 
notice 

The United Kingdom 
Telecommunications 
Act 1984 
This apparatus is approved 
under the approval number 
NS/G/1234/J/100003 for the 
indirect connections to the 
public telecommunications 
systems in the United 
Kingdom.

Energy Star
The EPA ENERGY STAR 
Computers program is a 
partnership effort with 
computer manufacturers to 

promote the introduction of 
energy-efficient products 
and to reduce air pollution 
caused by power generation.

Companies participating in 
this program introduce 
personal computers, 
printers, monitors, or fax 
machines that power down 
when they are not being 
used. This feature will cut 
the energy used by up to 50 
percent. Lexmark is proud to 
be a participant in this 
program.

As an Energy Star Partner, 
Lexmark International, Inc. 
has determined that this 
product meets the Energy 
Star guidelines for energy 
efficiency.

Power Supply 
information 
If your power supply fails, 
replace it with the Lexmark 
replacement part.

Safety 
information
• If your product is NOT 

marked with this symbol 
, it MUST be 

connected to an electrical 
outlet that is properly 
grounded.

• The power supply must 
be connected to an 
electrical outlet that is 
near the product and 
easily accessible.

• Refer service or repairs, 
other than those 
described in the 
operating instructions, to 
a professional service 
person.
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• This product is designed, 
tested and approved to 
meet strict global safety 
standards with the use of 
specific Lexmark 
components. The safety 
features of some parts 
may not always be 
obvious. Lexmark is not 
responsible for the use of 
other replacement parts. 
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Index

A
aligning print cartridges 

5, 50
Arrow button

locating 11
using 11

Auto Enhance 27

B
back to front printing 46

loading paper 46
background printing 

options 36
banding 60, 62
booklets

building 45
bundling 45
printing 44

borderless prints 22
borders, adding 25
both sides of the paper

customizing print 
settings 41

brightness control
locating 11
using 11

brightness feature 27
Built-In color matching 64
buttons, operator panel 

11

C
cable

connections 10
USB 10

camera card
choosing 12
cover 9
erasing photos 31
inserting 12
slot, locating 12

camera compatibility, 
verifying 11

camera order, print 13, 
23

camera, compatibility list 
11

captions, adding 25
card reader, PC 13, 38
cartridges, print

aligning 5, 50
cleaning 53
gold contact area 2
installing 2, 48
preserving 55
removing 48
replacing 48

color options 35
colors, wrong 60
ColorSync color matching 

64
compatibility list, camera 

11

connecting
external device 10
Power supply 10
USB/PC 10

Control Panel 48
Copy Failed Disk Full 57
Copy Failed Write 

Protected 57
copying photos 30
cover, camera card 9
crop photos, using 23
custom size paper

loading 34
settings 38

customer support 65
customizing

Page Setup 36
Print dialog 35

customizing print settings
both sides of the paper 

41
duplex printing 41
handouts 43
last page first 46
pages per sheet 43
two-sided printing 41

D
Decode Error 58
default settings, changing 

37
defaults

factory, resetting 28



In
d

ex

74

Display window
locating 11
using 11

downloaded printer 
driver, installing 67

duplexing 41

E
electronic emission 

notices 69
erasing photos 31
error messages

Cannot read Card 57
Carrier Stall 57
Copy Failed Disk Full 

57
Copy Failed No Disk 

58
Copy Failed, Write 

Protected 57
Decode Error 58
Erase Failed 58
Printer Offline 61

exit tray
locating 9
using 9

external storage device
connecting 10, 29

F
factory defaults, resetting 

28
FCC statement 69
frames, adding to a photo 

25
front cover

locating 9
using 9

G
general option 35

H
handouts

customizing print 
settings 43

handouts, printing 42
help, technical support 

65

I
idle screen 14
index, printing 13, 23
Industry Canada 

Compliance Statement 
70

installing
print cartridge 48
printer software 6, 67

intermittent printing 60, 
62

iron-on transfers
loading 34
settings 38

J
Japanese VCCI notice 

70

K
KODAK Premium Picture 

Paper
settings 37

Kodak templates 21

L
languages, changing 14
last page first

loading paper 46
printing 46

layout 35
changing 13
choosing 20

loading paper 4, 34

M
Mac OS 8.6 33
Mac OS 9 33
Macintosh, printing

Print dialog box 35
main menu

understanding 17
using 17

Menu buttons
locating 11
using 11

messages, error
Cannot read Card 57
Carrier Stall 57
Copy Failed Disk Full 

57
Copy Failed No Disk 

58
Copy Failed, Write 

Protected 57
Decode Error 58
Erase Failed 58
Printer Offline 61

N
notices

electronic emission 69
European Community 

directives conformity 
70

FCC 69
Industry Canada 

Compliance 
Statement 70

Japanese VCCI notice 
70

United Kingdom 
Telecommunications 
Act 1984 70

nozzles, print
cleaning 51, 52
wiping 53
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O
operator panel

buttons 9
error messages 57
using 9

ordering replacement, 
power supply 70

P
page layout, choosing 20
page settings, changing 

36
Page Setup 35
pages per sheet

customizing print 
settings 43

Panoramic 21
paper

choosing 18
loading 4
size, choosing 19
types 18

paper exit tray
locating 4, 9
using 4, 9

paper feeder
See sheet feeder

paper guide 9
paper loading 34
paper support 9
part number, USB cable 

69
PC card reader 13
photo and print preview, 

using 14
photo cards

loading 34
photo paper, problems 

64
photos

adding frames 25
adding text 25
auto enhance 27
brightness 27

colors wrong 60
copying to zip drive 30
cropping 24
editing 23
erasing from the 

camera card 31
layout, choosing 13, 

20
modifying text 26
rotating 24
selecting 22
storing 30
viewing 13

photos to print option, 
using 22

popup menus
background printing 

options 36
color options 35
general option 35
layout option 35

power connection 10
power supply 70

connecting 1
ordering replacement 

70
print all photos 13
Print button

locating 11
using 11

print cartridges
aligning 5, 50
contacts, cleaning 53
gold contact area 2
installing 2, 48
preserving 55
removing 48
replacing 48

Print dialog 35
print nozzles 53

cleaning 51, 52
wiping 53

print quality
banding 60, 62
changing 20

different colors 64
missing colors 64
smudged 63
too dark 63

print settings, specialty 
paper 37

Print Sizes 21
printer driver

downloading 67
installing 67

printer driver Help, 
accessing 48

printer parts
locating 9
using 9

Printer Properties
customizing

for booklets 44
printer setup 6
printer software

Control Panel 47
installing 6
Print dialog 35

printer, setting up 1
printing

all photos 23
basics 33
booklets 44
camera card order 23
changing page 

settings 36
changing print settings 

36
customizing print 

options 35
documents 38
from an application 38
from zip drive 31
handouts 42
index 23
last page first 46
on both sides of the 

paper 41
Page Setup dialog box 

35



In
d

ex

76

photos 17
selected photos 23
sets 23
test page 6
text on photos 25
with Macintosh 33

printing options 35
printing problems

color quality 64
error messages 57
intermittent 60, 62
missing colors 64
paper jam 59
paper misfeeds 63
with computer 61

R
release tab 9
removing print cartridge 

48
reverse order printing 46

loading paper 46

S
safety information 70
screen, idle 14
Select button

locating 11
using 11

selected photos, printing 
23

sets, printing 23
setting recommendations

booklets 44
custom size paper 38
handouts 43
iron-on transfers 38
KODAK Premium 

Picture Paper 37
transparencies 37

setting up, printer 1
settings

two-sided printing 41
sheet feeder 9

software, printer
installing 6

specialty papers
custom size paper 34
iron-on transfers 34
photo cards 34
transparencies 34

start-up screen, using 13
storage device, 

connecting 29
storing photos 30
supplies, ordering

power supply 70

T
technical support 65
templates, Kodak 21
test page

alignment 5, 50
does not print 62
nozzle test pattern 51, 

53
printing 6

text
adding to a photo 25
modifying 26

transparencies
loading 34
problems 64
settings 37

troubleshooting
blank pages 62
color quality 60, 64
general 62
missing colors 51, 64
operator panel error 

messages, 
understanding 57

paper sticks together 
64

printer settings 62
printing problems 61
problems, computer 

61

U
United Kingdom 

Telecommunications 
Act 1984 70

USB cable
part number 69

USB/PC connection 10

V
View/Return button

locating 11
using 11

W
Warranty 67
Web site, KODAK 11, 65

Z
zip drive

connecting 10, 29
copying to 30
printing from 31
storing photos 30
using 30


	Getting started
	Setting up your printer
	Installing the print cartridges
	Loading paper
	Aligning the print cartridges
	Printing a test page
	Setting up your printer with Macintosh


	Understanding your printer
	Identifying the parts of your printer
	Using the operator panel
	Verifying camera compatibility
	Inserting a camera card
	Using the Quickstart screen
	Using Photo and Print Preview
	Understanding the Idle Screen
	Changing Languages

	Printing photos without a computer
	Understanding the Printer Menus
	Choosing a paper type from the operator panel
	Choosing a paper size
	Changing print quality
	Choosing the page layout
	Selecting photos to print
	Using the Photos to Print option
	Choosing the number of sets to print
	Photo Editing Selections
	Cropping photos
	Rotating a photo
	Selecting a border for your photo
	Adding text to your photo
	Brightness feature
	Auto Enhance

	Resetting Defaults

	Using an external Zip drive
	Connecting your external Zip drive
	Attaching your printer to the Zip drive
	Copying photos to your Zip drive
	Erasing photos from your camera card
	Printing from your Zip disk

	Printing with Macintosh
	Step 1: Load the paper
	Step 2: Customize the printing options
	Step 3: Print your document
	Understanding the Card Reader

	Printing beyond the basics
	Printing on both sides of a sheet of paper
	Printing handouts
	Printing booklets
	Printing last page first

	Caring for your cartridges
	Using your computer for cartridge maintenance
	Using your operator panel for cartridge maintenance
	Cleaning and preserving print cartridges

	Troubleshooting
	Understanding the operator panel error messages
	Printing problems without a computer
	Printing problems with your computer
	General printing problems with or without your computer
	KODAK Customer Support Center

	Appendix
	Installing printer software
	Uninstalling printer software for Macintosh
	Statement of Limited Warranty
	Electronic emission notices
	Notices
	European Community (EC) directives conformity
	Energy Star
	Power Supply information
	Safety information

	Index

